
SPMS FUNCTIONALITY FOR SCIENTIFIC PROGRAMME 
MANAGEMENT DURING A CONFERENCE 
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Abstract 
This presentation provides an overview of how the 

SPMS interfaces are used during the conference for the 
management of the activities relating to the scientific 
programme. Activities are Editor, Editor/QA, Author 
Reception, Presentations Management, Poster Session 
Management. 

See also the documentation published at the SPMS 
Documentation site at Elettra.* 

PROCESSING CONTRIBUTIONS 
Aim 

The aim of the Editorial Team is to process and publish 
“pre-press” all contributions submitted to the conference 
by the last day of the conference, and, together with the 
transparencies of the oral presentations, on JACoW 
within approximately three to four weeks.  

This aim is feasible, has been achieved on several 
occasions, but depends on a number of critical issues 
including the number of editors, their competence, the 
soft- and hardware installation, and internet speed. 

Schedule 
To achieve this optimistic goal, a pre-conference team 

of “core” JACoW editors begins processing on the 
Thursday prior to the conference, aiming to process 
approximately 80% of all contributions by the Sunday, 
when delegates arrive.  

A further team, including “novice” JACoW editors, 
joins the “core” team on the Sunday for basic hands-on 
training in electronic publication techniques under the 
supervision of the “core” editors, trying its hand on the 
remaining 20% of contributions. 

From the Monday of the conference the “core” team 
begins Quality Assurance, which consists of a double 
check of each contribution already processed. Normally 
an editor does not QA his/her own work. 

Templates 
All contributions must be prepared according to the 

JACoW templates. 

Processing and Quality Assurance 
Guidelines for the processing of contributions are 

published at the JACoW site regularly. See for instance 
those published in connection with IPAC’11 at: 
http://accelconf.web.cern.ch/AccelConf/JACoW/Documen

ts/IPAC11/Ed-Instructions-IPAC11.html 
Once contributions have been processed, they move on to 
be quality assured. Guidelines for Quality Assurance 
published in connection with IPAC’11 are published here: 

http://accelconf.web.cern.ch/AccelConf/JACoW/Documen
ts/IPAC11/Quality_Assurance.htm 

Common oversights are published here: 
http://accelconf.web.cern.ch/AccelConf/JACoW/Documen

ts/IPAC11/Common_Oversights.htm 
It is up to the individual editors-in-chief how strictly to 

apply exact layout of papers as shown in the templates. 
For example, the criteria might be “stretched” depending 
on the number of contributions to be processed, and the 
number of editors in the team. 

Privileges for Conference Editors 
The “Editor” privilege allows access to the screen used 

by editors to call up papers to be processed: 
Conference instance  url_debug/editor.html 

Editors are allowed access to numerous other screens, 
assigned by the Administrator via the Web Pages. They 
are typically the possibility to search over all 
contributions, access to Reports and Statistics, and to the 
“Activity Log – Staff”, which provides an overview of the 
“performance” of all editors for the activities entered in 
the screen “Contribution Log Codes” with “Yes” in the 
column “Activity Log”. The possibility to send e-mail to 
contributors is also possible. 

Editor/QA Privileges 
The Editor/QA privilege allows access to the screen 

conference instance url_debug/editor.qa 

AUTHOR RECEPTION 
The Author Reception staff: 

- provide the interface between authors and editors 
- file the hard copies of the contributions to the 
proceedings processed by the editors 
 
staff normally arrive on the Sunday morning. They have a 
brief training session, and normally begin immediately 
filing all of the hard copies of the contributions processed 
by the editorial staff.  

- files the hard copies of the contributions processed by 
the editorial team 

provides the interface for authors with questions. The  

PROCESSING TRANSPARENCIES 
Oral presentations are published in the conference 

proceedings, though the pdf files are not cropped to 
“JACoW page size”. 

Transparency processing normally begins as soon as 
the oral presentations have taken place, working at the 
pace of the oral presentations programme. 

Guidelines for Transparency Processing are published 
at the JACoW.org site under  
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For Conference Editors / Documents / Processing 
Transparencies for Proceedings / Guidelines for editors 

Transparency Processing Editor Privileges 
SPMS functionality relating to the processing of 

transparencies was recently improved with the creation of 
a new screen for processing management and 
Transparency Editor privilege at: 

conference instance url_debug/transparencies.html 
The transparency editor can now download, upload, 

assign a status and e-mail the author.  

PRESENTATIONS MANAGEMENT 
The Presentations Manager has the task of retrieving 

files of oral presentations, checking them, uploading them 
to the auditoria, and ensuring professional presentation 
conditions on stage. There is normally one Presentations 
Manager available throughout the conference in the 
Speaker Preparation Room, plus a Manager on hand in 
each auditorium. 

Wherever possible, the conference should insist that 
presentations are uploaded via SPMS, and discourage the 
use of private laptops by speakers. This ensures speedy 
checking and transfer of presentations to the auditoria, 
and that the files are available on the file server for 
processing immediately following the presentation. 

The Presentations Manager needs to be completely 
familiar with the Presentations setup at the venue, the 
software available there, or to be installed. He/she 
collaborates with the Scientific Secretariat in the 
preparation of Guidelines for speakers to ensure a) that 
presentations are properly visible by the audience (font 
size, etc.), and b) that the authors indicate any “special” 
software they may need, in particular relating to 
animations, movies, etc. 

The IPAC’11 Guidelines for Speakers are reproduced 
in Annex 2. 

IPAC “employs” students with grants to act as 
scientific secretaries, assisting the Session Chairs on stage 
during the oral presentations. Students are invited to 
indicate the session where they would like to act as 
scientific secretary. The Presentations Manager normally 
organizes training sessions for the students in what is 
required to set up a session for the oral presentations on 
stage, and to work the Speaker Timer software. A 
“Speaker Timer” application was developed for 
EPAC’04, re-worked for EPAC’08. Contact 
Ivan Andrian/Stefano Deiuri, Elettra. 

The Presentations Manager privileges are set up by the 
Administrator via the Authorize Screen. Access is to two 
screens in particular. 

The “working” screen: 
Conference url_debug/transparencies.display 

showing the schedule of oral presentations, and where 
files have been uploaded. There are links to download the 
files from the server in order to check them, and also to 
upload files should the authors arrive with memory sticks. 

There is also a link to Email speakers to remind them of 
the deadline for upload, should they have forgotten …. 

Presentations Manager privilege also allows access to 
the screen: 

Conference url_debug/agenda.html 
which is similar to the InDiCo screen, showing the 
complete conference schedule, and where _talk files have 
been uploaded. 

POSTER SESSION MANAGEMENT 
In earlier days, it was not uncommon to see three pages 

of a contribution to the proceedings posted in a poster 
session, with no author in sight …. And to make matters 
worse, huge numbers of gaps in posters. 

Many efforts to improve the quality of the poster 
sessions have been introduced over the years, and 
common publication policy has evolved whereby only 
work properly presented in the poster sessions can be 
accepted for publication in the conference proceedings. 
The SPC can reserve the right to reject for publication any 
work not properly presented …. Authors these days are 
warned several times over of this policy, and invited to 
withdraw work that cannot be presented. The situation has 
improved over the years, in particular in the quality of the 
posters, but authors unable to present their work 
unfortunately omit to withdraw it, and the number of 
empty poster panels remains around 12%. 

Poster Session Management was introduced to check 
that posters are posted, manned, and of adequate “quality. 
Managers are also available to assist presenters in 
mounting and dismounting posters, and most importantly, 
to record the status of each poster. 

 Poster Session Managers have the privilege to access 
the screen 

Conference url_debug/poster_police.html 
Each Poster Session is listed, and by clicking on “edit”, 
the full list of posters scheduled in the session is visible. 
The columns “Manned”, “Posted”, “Satisfactory” are set 
by default to “Yes”. 

The job of the Poster Session Manager immediately 
following each session is to ensure that these three flags 
are correctly set, changing to “No” the instances where 
posters are not manned, posted, and of satisfactory 
quality. Instances where the quality is not up to standard 
are immediately communicated to the Scientific 
Secretariat or SPC Chair such that the authors/presenters 
may be contacted during the session to discuss whether 
the policy of excluding the work from the proceedings 
should be applied. 

A further column “Picture” is defaulted to “No”, but 
which can be set to “Yes” to back up the quality problem, 
or any other problem, to be described in the last column 
“Comments”. 

The three flags “manned”, “posted”, “satisfactory” are 
used by the SPMS to indicate that papers are OK to be 
published in the proceedings. Any contribution without 
all three flags will not be seen by the scripts which pull 
the proceedings together for the final publication package. 
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PRE-PRESS PUBLICATION 
Following the conference, it is in the interest of the 

conference to publish at least those papers that have been 
presented, processed, and QA'd as early as possible.  

All papers flagged “contribution posted, manned, of 
good quality, and QA OK” are normally transferred to a 
new server, or different part of the server used for file 
upload. The url of the location of the files is entered into 
the screen 
System Parameters / URLs / Proceedings TOC Base URL 

This url is normally communicated to all authors to 
allow prompt access the pdf files of all processed papers 
meeting the required criteria, awaiting final publication at 
the JACoW site, once all of the late submissions will have 
been properly received and processed, and once the 
necessary verifications (cross-checking titles and authors 
in SPMS against the papers, etc.) will have been 
completed. 
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Annex 1: Common Oversights 
 
IS THE TITLE IN UPPER CASE? 
 
The title should use 14 pt bold UPPERCASE letters 
(except for units, e.g. GeV) and be centred on the page. 
 
Authors 
 
The names of authors, their organizations/affiliations, and 
mailing addresses should be in 12 pt uppercase and 
lowercase letters. When there is more than one author, the 
submitting author should be first, followed by the co-
authors. Co-authors should be grouped by affiliation and 
then listed alphabetically. 
 
SECTION HEADINGS 
 
SECTION HEADINGS should NOT be numbered, use 12 
pt bold UPPERCASE and be centred in the column. 
 
Subsection Headings 
 
Subsection Headings use 12 pt italic lowercase and 
uppercase.  The initial letters are capitalized, and the 
heading is left aligned in the column. 
 
Figures 
 
Figure captions should be placed below the figure and 
centred if on one line, but adjusted if spanning two or 
more lines: 
 

Figure 1: A one line figure caption. 
Figure 2: A figure caption that takes two lines is 
justified 

 
Note the colon “:” after the figure number and the period 
“.” At the end of th caption. 
 
When referring to a figure from within the text, the 
convention is to use the abbreviated form, i.e. Fig. 1, 
unless the reference to the figure is at the start of the 
sentence: 
 
Figure 1 shows a schematic view of … 
 
… as shown in Fig. 1. 
 
Tables 
 
The publishing standards of today dictate that tables are to 
be drawn without vertical lines. See Table 1 in the 
template. 
 
Table Headings should be placed above the table and 
centred if on one line, but adjusted if spanning two or 
more lines: 

 
Table 1: Table Heading 
 
Table 1: A Particularly 
Long Table Heading 
Spanning Two Lines 

 
Note the colon “:” after the table number, initial letters of 
the Table Heading are capitalized, and the absence of a 
period at the end of the caption. It is also acknowledged, 
however, that in some instances authors find it necessary 
to replace the Table Heading with an actual sentence.  In 
such case, the formatting rules given for Figure captions 
is best followed. The Table caption should, however, 
always be placed above the table. 
 
When referring to a table from within the text, the 
convention here is NOT to abbreviate, i.e. Table 1. 
 
Equations 
 
If a displayed equation requires a number, it should be 
placed flush with the right margin of the column. 
 
References 
 
References are written in 10 pt and should be justified 
with 7 mm hanging indent (using Word terminology) i.e. 
neatly presented with reference numbers aligned. 
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Annex 2: Guidelines for Speakers 

Oral presentations will be made electronically using 
the beamer equipment provided by the Conference 
Centre. 

A Speaker Presentation Office is located at the 
Conference Centre for speakers to check presentations on 
the electronic preview system. 

Angeles Faus-Golfe, the Presentations Manager, should 
be contacted well in advance of the conference with any 
special requirements concerning visual aids, including 
movies. 

Speakers are invited to upload their presentation, in 
exactly the same way as their contributions to the 
Proceedings (see the Guidelines for the Submission of 
Contributions), at the very latest on the day before their 
scheduled presentation time in order to allow verification 
and transfer to the Conference Centre´s system. 

Please note that in addition to the presentation we 
require a PDF file of the presentation for inclusion in 
the conference proceedings. 

The following precautions should be adhered to, to 
ensure smooth running of electronic presentations: 

For PowerPoint files, use only TrueType fonts and embed 
them: 

To embed fonts in PowerPoint XP / 2007:  

1. Select the Office Button and select Power Point 
Options. 
2. Under Save options, select the Embed fonts in the file 
checkbox and Embed only the characters used in the 
presentation. 

To embed fonts in PowerPoint XP / 2003: 

1. On the Tools menu, click Options, and then click the 
Save tab. 
2. Under Save options, select the Embed True Type fonts 
check box. 

To embed fonts in PowerPoint 2000: 

1. On the File menu, click Save As. 
2. Click the Tools menu in the toolbar at the top of the 
Save As dialog box. 
3. On the menu that appears, select Embed TrueType 
Fonts. 
4. Save the file as a PowerPoint Presentation. 

For PDF files, be sure to include all fonts when preparing 
the PostScript and PDF files, too. 

The following software will be pre-installed on the 
computers for the presentations: 

MS Office 2007, Win Zip, Internet Explorer, Firefox and 
Acrobat Reader will be installed for Windows PCs. Office 
2008, Firefox and Acrobat Reader will be installed for 
Macintosh. 

UPLOAD OF PRESENTATIONS 

The files of presentations should be uploaded to our 
fileserver as early as possible, but at latest on the day 
before the presentation. Files should be named with the 
programme code and "_talk" (for example 
MOXAA01_talk.ppt, _talk.pdf, etc.) and then uploaded in 
the same way as for papers through JACoW SPMS 
IPAC´11 Author Accounts. The programme codes 
assigned to presentations are visible when logging into 
accounts, or via the "search" functionality. 

Those authors who are unable to upload to the server 
should copy the file to a CD or memory stick and bring it 
to the Speaker Presentation Office or Author Reception at 
least one day before the presentation. 

Note that the computers used for the beamer presentations 
will be PC´s with Windows XP and Macintosh with Mac 
OS 10.5 installed. There will be no provision for authors 
to use their own computers and if this will cause you 
problems, please contact the Presentation Manager, 
Angeles Faus-Golfe as soon as possible. 

No overhead projector is planned. Please contact the 
Presentation Manager, Angeles Faus-Golfe, if this is a 
problem. 

AT THE CONFERENCE 

Once the presentations have been uploaded to the server, 
they can be checked on the Conference Centre’s 
computers in the Speaker Presentation Office. 

Slides that have been successfully captured will be 
published in the web version of the proceedings without 
further action on the part of the speaker. 

Official Opening Hours of the Speaker Presentation 
Office: 

Sunday, 4 September 
16:00 – 18:00 
Monday to Thursday, 5-9 September 
08:30 – 10:30 
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12:30 – 13:30 
16:00 – 18:00 
Friday, 9 September 
08:30 - 10:30 

Speakers who need to check their presentations outside of 
the above hours should contact Christine Petit-Jean-
Genaz at the Author Reception. 

DURING THE PRESENTATION 

The Scientific Secretary on the podium will help speakers 
with their presentations. Please contact the Scientific 
Secretary just before the start of the session. 

On the podium speakers will be presented with an LCD 
screen displaying their presentation, a powerful laser 
pointer and a simple remote to control the presentation. 

In case of problems, the Scientific Secretary will be in 
contact with the Conference Centre technical staff who 
have complete control over presentations. 

The remaining time of each talk will be displayed on a 
small timer located on the podium. 

Please do not hesitate to contact the Presentations 
Manager, Angeles Faus-Golfe, or the Scientific 
Secretariat Christine Petit-Jean-Genaz for further 
clarifications. 
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